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LỜI GIỚI THIỆU 

Dựng phim là một nghệ thuật, nơi mà những khung hình, âm thanh, và cảm xúc 

hòa quyện để tạo nên những câu chuyện sống động. Trong thế giới công nghệ số hiện 

nay, Adobe Premiere Pro đã trở thành một trong những công cụ dựng phim mạnh mẽ 

và được ưa chuộng nhất, từ những nhà làm phim chuyên nghiệp đến những người 

đam mê dựng phim nghiệp dư. 

Giáo trình này được thiết kế nhằm giúp bạn khám phá và nắm vững các kỹ năng 

cần thiết để sử dụng Adobe Premiere Pro một cách hiệu quả. Với cấu trúc bài học rõ 

ràng, từ cơ bản đến nâng cao, chúng tôi hy vọng rằng bạn sẽ dễ dàng tiếp cận và áp 

dụng những kiến thức vào thực tế. 

Mục Tiêu của Giáo Trình: Giới thiệu tổng quan về Adobe Premiere Pro: Để bạn 

làm quen với giao diện và các tính năng chính của phần mềm. Hướng dẫn các kỹ năng 

dựng phim cơ bản: Bao gồm nhập liệu, sắp xếp, và chỉnh sửa video. Nâng cao kỹ 

năng qua các kỹ thuật chuyên sâu: Chỉnh màu, âm thanh, và các hiệu ứng đặc biệt. 

Thực hành qua các dự án thực tế: Giúp bạn áp dụng những kiến thức đã học vào 

những dự án cụ thể, từ đó nâng cao kỹ năng và sự sáng tạo của mình. 

Cuối mỗi chương đều có hệ thống các bài tập vận dụng được thiết kế từ dễ đến 

khó, từ đơn giản đến phức tạp nhằm kiểm tra, củng cố kiến thức đã học cũng như 

giúp sinh viên hệ thống kiến thức, vận dụng kiến thức để giải quyết các tình huống 

trong các bài tập. 

Do thời gian nghiên cứu và biên tập có hạn, giáo trình này không thể tránh khỏi 

những thiếu sót, tôi rất mong sẽ nhận được những ý kiến đóng góp quý báu của quý 

đồng nghiệp và các bạn sinh viên để giáo trình hoàn thiện hơn.  

Trân trọng ! 

 Thành phố Hồ Chí Minh, ngày    tháng    năm 2021 
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1. Adobe Premiere là gì? 

Adobe Premiere là một ứng dụng chỉnh sửa video được phát triển và phát hành 

bởi Adobe Systems, với các chức năng chính: dựng phim, cắt ghép, biên tập, tinh 

chỉnh, thêm hiệu ứng đơn giản cho clip. Ngoài ra, phần mềm này còn hỗ trợ nhiều định 

dạng video, cho phép người sử dụng có thể chia sẻ trên nhiều nền tảng, phương tiện 

truyền thông.  

 

2. Làm quen với giao diện phần mềm 

Adobe Premiere được thiết kế với giao diện đơn giản, thân thiện với người sử 

dụng với cách bố trí các thanh công cụ gọn gàng, thông minh. Nhờ vậy mà hiệu xuất 

làm việc được cải thiện, tiết kiệm thời gian với hệ thống công cụ hỗ trợ tối ưu. 

Giao diện làm việc của Premiere được thiết kế với 6 phần chính:  
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- Menu bar:  

- Program bar: hiển thị sản phẩm sau quá trình dựng, phép xem lại video trực 

tiếp, hình ảnh, âm thanh, effect đã thao tác trong quá trình dựng. 

- Soure pan: xem lại các file nguồn. 

- Project and media: Cửa sổ dự án – Đây là nơi chứa tất cả các file nguồn đã 

import, các title tạo trong khi dựng, các hiệu ứng, kỹ xảo của chương trình 

- Timeline: Đây là cửa sổ xuất hiện tiến độ làm việc của sequence, bao gồm các 

đường hình (Video tracks) và các đường tiếng (Audio tracks). 

- Toolbar: Bao gồm các công cụ hỗ trợ: cắt ghép, di chuyển, chèn chữ,... 

 

3. Thao tác chính khi làm việc với Premiere 

a. Tạo Project 

Để có thể bắt đầu chỉnh sửa hay biên tập video trong Premiere, bạn cần tạo ra 

projects mới để có thể quản lí các file gốc, clip sau khi hoàn thành, giúp chỉnh sửa 

nhanh chóng và dễ dàng khi cần thiết.  
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Các bước thực hiện:  

Bước 1: Khởi động phần mềm, chọn new project, sau đó cửa sổ như phía dưới 

sẽ ngay lập tức hiện ra.  
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Bước 2: Điền các yếu tố cần thiết trong bảng:  

- Name: Đặt tên cho project 

- Location: Chọn thư mục chứa project 

Bước 3: Nhấn Ok hoặc Enter là hoàn thành.  

b. Tạo Project khi AP đang mở  

Khi đang thực hiện cắt ghép hoặc biên tập video mà muốn tạo một project mới, 

bạn có thể làm theo những cách sau:  

Cách 1 : Trên thanh Menu, chọn :  File >New > Project.  

Cách 2 : Phím tắt CTRL + ALT + N (máy win)  hoặc COMMAND + ALT + N (máy 

mac) 

c. Tạo sequence 

Sequence trong Premiere là nơi diễn ra mọi thao tác chỉnh sửa và biên tập video.  

Khi bắt đầu một project mới, bạn đều cần tạo một sequence mới ngay sau khi 

bắt đầu, hay có thể thêm vào trong quá trình chỉnh sửa video, tuỳ thuộc vào nhu cầu 

của bạn khi làm việc với phần mềm.  

Cách tạo sequence:  

Bước 1: Trên thanh công cụ Menu, chọn File >  New > Sequence. 
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  Hoặc trong Project Panel > Nhấn chuột  vào biểu tượng New Item > Sequence 

 

Bước 2: Chọn một Sequence Preset  được thiết lập trước : 

Trong thẻ Sequence Presets, lựa chọn một Sequence preset được thiết lập trước 

trong danh sách Available Presets. 

Bước 3: Đặt tên cho Sequence : 
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Ở mục Sequence Name, đặt tên cho Sequence rồi chọn OK. 

 

d. Import file 

Sau khi đã tạo xong project, bạn cần đưa toàn bộ nguyên liệu cần biên tập vào 

trong phần mềm hay còn được gọi là import file. Bạn có thể lựa chọn 1 trong 3 cách 

dưới đây:  
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Cách 1 : Menu > File > Import > Chọn các video > OK 

 

Cách 2 : Kéo footage nguyên liệu từ  bên ngoài thả vào Project Panel. 

Cách 3 : Phím tắt: CTRL + I (máy win) 

                              COMMAND + I (máy mac) 

e. Cắt ghép video 

Để có thể thực hiện thao tác cắt video trong Premiere, bạn cần chú ý 1 vài công 

cụ sau:  

https://colorme.vn/blog/huong-dan-chi-tiet-cat-ghep-video-bang-adobe-premiere-95977
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- Move Tool (V):  cho phép kéo dài và rút ngắn lại video khi đưa chuột đến đầu 

phần audio hoặc video cần cắt.  

- Razor Tool (C)  Dùng để cắt video hoặc audio theo ý muốn trên timeline. 

Tuỳ vào mục đích, bạn chỉ cần lựa chọn 1 trong 2 công cụ thể và thực hiện thao 

tác với video trên timeline là hoàn thành 

 

Để ghép các video trong Premiere, cần phải sử dụng đến các hiệu ứng chuyển 

cảnh - video transition.  

f. Chỉnh âm thanh 

Khi làm việc với các file âm thanh trong phần mềm Premiere, ngoài 2 công cụ là: 

Move Tool và Razor Tool, bạn cần nắm thêm 1 vài công cụ sau:  

- Tắt tiếng 1 thanh audio :  Ấn icon M ở đầu thanh audio trên timeline. 

- Chỉ cho 1 kênh  âm thanh phát tiếng : Bấm chọn icon S ở đầu thanh âm trong 

timeline. 
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Để có thể tuỳ chỉnh âm thanh tạo sự liên kết với video, ngoài các công cụ trên, 

bạn cần thêm 1 vài hiệu ứng khác để tạo sự chuyển động mượt mà giữa các file. Thao 

tác cần nhớ như sau:  

Bước 1: Chọn clip chứa đoạn âm thanh cần tinh chỉnh.  

Bước 2: Mở Effect => Audio transitions => Chọn lựa hiệu ứng phù hợp 
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Bước 3: Kéo thả hiệu ứng vào vị trí âm thanh đang cần chỉnh. 

Bước 4: Điều chỉnh độ ngắn dài của transitions trực tiếp trên timeline hoặc effect 

controls. 

Ngoài ra, bạn có thể tham khảo cách chèn nhạc cho video để thêm phần hấp dẫn 

nhé! 

 

 

g. Tạo chuyển động 

Để tạo chuyển động trong Premiere, chúng ta cần phải làm việc với 

“keyframe”. Keyframe là vị trí trên một đường thời gian đánh dấu sự bắt đầu hoặc kết 

thúc của quá trình chuyển đổi, tạo hiệu ứng di chuyển của một đối tượng đi từ điểm A 

đến điểm B trong dòng thời gian. 

https://colorme.vn/blog/tron-bo-huong-dan-chinh-am-thanh-trong-premiere-pro-cc-phan-1
https://colorme.vn/blog/keyframe-la-gi-tam-quan-trong-cua-keyframe-trong-san-xuat-video
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Ngoài ra, bạn còn phải làm việc với Video Effects áp dụng hiệu ứng chuyển động 

có sẵn trong phần mềm cho video, tuỳ vào từng yêu cầu. Hầu hết các trường hợp thì 

chúng  ta sẽ chỉ sử dụng Motion và Opacity trong Video effect. 

 

 

Tạo keyframe trong Premiere:  

Bước 1: Chọn điểm bắt đầu: 

Đây là vị trí mà bạn mong muốn đoạn clip sẽ được phóng to, thu nhỏ hay xoay 

tròn,... Trên timeline, công cụ điều khiển thời gian sẽ ở điểm đầu của  đoạn clip đó.  

Bước 2: Keyframe. 

- Click vào đoạn clip đó trên timeline.  

- Vào mục Effect control => chọn đúng hiệu ứng (effect) cần để sử dụng.  
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- Click vào biểu tượng có hình đồng hồ bên cạnh hiệu ứng vừa chọn trong effect 

control. 

Bước 3: Chọn điểm kết thúc:  Là vị trí mà tại đó, hiệu ứng sẽ kết thúc.  

 

Bước 4: Thay đổi thông số hiệu ứng. 

Thay đổi thông số của hiệu ứng đã kích  hoạt keyframe cho phù hợp với yêu cầu. 

Bạn có thể thay đổi tính chất của hiệu ứng: kích thước, thời gian, số lần chuyển động,... 

đến khi được như mong muốn.  

h. Thêm text 

Sau khi đã chỉnh sửa xong hiệu ứng, âm thanh, tuỳ vào yêu cầu đặt ra, bạn cũng 

có chèn chữ vào trong video của minh để mô tả rõ ràng hơn cho video của mình.  

 

j. Chỉnh màu video  
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Mỗi một màu sắc lại mang một sắc thái khác nhau, khơi dậy nên cảm xúc trong 

tâm trí của người xem. Do vậy đây được coi là thao tác vô cùng quan trọng, sẽ giúp 

bạn tạo nên sự độc đáo và khác biệt cho video của bạn, tăng tính cảm xúc cho video 

và kể câu chuyện một cách trực quan nhất.  

 

Để chỉnh màu trong Premiere, bạn có 2 cách lựa chọn:  

Cách 1: Chỉnh video dựa trên preset màu có sẵn - LUT.  

Cách 2: Tuỳ chỉnh màu sắc bằng công cụ Lumetri Color.  

Giao diện chính của Adobe Premiere chia thành 5 vùng mà ta cần phải nắm rõ chức 

năng của từng vùng để tránh bị nhầm lẫn cũng như hoa mắt khi lần đầu sử dụng phần 

mềm này cũng như dễ dàng hiểu sâu hơn về hướng dẫn sử dụng Adobe Premiere 

trước khi bắt tay vào thao tác các công cụ trên phần mềm 
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- Khu vực 1: Project Pannel đây là cửa sổ dự án nơi chứa tất cả các file nguồn đã 

import và title tạo trong quá trình dựng phim 

- Khu vực 2: Source Monitor đây là màn hình giúp người dùng xem lại các file nguồn 

- Khu vực 3: Program Monitor đây là cửa sổ chứa các sản phẩm của chính bản dựng 

lên. Màn hình này cho phép tất cả các hình ảnh, âm thanh và cả effect thực hiện trong 

quá trình dựng được phát lại cho người dùng xem thành quả và kiểm tra 

- Khu vực 4: Effect Pannel đây là nơi bạn có thể tìm các hiệu ứng, kỹ xảo của chương 

trình 

- Khu vực 5: Timeline Pannel đây là khu vực theo dõi tiến độ làm việc cảu sequence 

gồm đường hình hay còn gọi là Video tracks và đường âm thanh - Audio tracks 

Ngoài cửa sổ giao diện chính này ra cũng cần phải làm quen với một số cửa số làm 

việc khác sẽ sử dụng đến trong quá trình dựng phim của mình. Đó là  
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- Effect Controls đây là cửa sổ dùng riêng để điều chỉnh hiệu ứng âm thanh và hình 

ảnh 

 

- Audio Mix đây là nơi bạn sáng tạo, cắt ghép, điều chỉnh âm thanh.  
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Như vậy là ta đã làm quen với các cửa sổ làm việc trong Adobe Premiere. Cùng bắt 

tay vào các bước dựng phim với phần mềm Adobe Premiere thôi 

Trở thành chuyên gia Adobe premiere bằng cách đăng ký học online qua video ngay. 

Khóa học sẽ giúp bạn làm quen và sử dụng thành thạo phần mềm Adobe Premiere - 

phần mềm dựng phim chuyên nghiệp. Đồng thời, bạn sẽ biết cách dựng một TVC, sân 

khấu ca nhạc, album cưới, kỉ yếu, giới thiệu sản phẩm cho doanh nghiệp… Đăng ký 

ngay để nhận ưu đãi hấp dẫn: 
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Quy trình dựng phim HD trên Adobe Premiere CC 

Phạm anh Dũng 

99.000đ 

600.000đ 

Đăng kýHọc thử 

 

 

Adobe Premiere cơ bản - Dựng phim cho doanh nghiệp (Cập nhật Adobe Premier 

2023) 

Lương Tuấn Kiệt 

299.000đ 

900.000đ 

Đăng kýHọc thử 

https://unica.vn/order/step1?id=1755
https://unica.vn/quy-trinh-dung-phim-hd-tren-adobe-premiere-cc?preview
https://unica.vn/order/step1?id=483
https://unica.vn/adobe-premiere-co-ban-dung-phim-cho-doanh-nghiep-cap-nhat-adobe-premier-2023?preview
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Dựng phim truyền thông đỉnh cao với Adobe premiere 

Master Trần 

299.000đ 

900.000đ 

Đăng kýHọc thử 

Tạo project, sequence mới  

Tạo project khi mới mở Adobe Premiere 

Bước 1: Ta bắt đầu khởi động phần mềm Adobe Premiere. Sau đó sẽ xuất hiện hộp 

thoại "Welcome to Adobe Premiere" 

https://unica.vn/order/step1?id=711
https://unica.vn/dung-phim-truyen-thong-dinh-cao-voi-adobe-premiere?preview
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Bước 2: Chọn New Project để tạo một dự án mới. 
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Bước 3: Xuất hiện hộp thoại New Project. Lựa chọn thư mục lưu dự án của bạn trong 

phần Browse. Đặt tên thư mục ở mục Name. 

Bước 4: Kết thúc bước tạo Project bằng nút OK 

Tạo Project mới khi AP đang mở 
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Cách 1: 

Bước 1: Chọn File => New => Project trên thanh công cụ Adobe Premiere 

 

Bước 2: Xuất hiện hộp thoại New Project. Lựa chọn thư mục lưu dự án của bạn trong 

phần Browse. Đặt tên thư mục ở mục Name. 

Bước 3: Kết thúc bước tạo Project bằng nút OK 

Cách 2: 

Sử dụng phím tắt CTRL +ALT + N (máy win) hoặc COMMND + ALT + N (máy mac) 

Tạo sequence mới 

Sequence nghĩa là một bản dựng trong một project được tạo. Một project có thể có 

nhiều sequence khác nhau. Đây là nơi diễn ra các thao tác biên tập, chỉnh sửa phim 

trên đó. Sau khi tạo xong 1 project mới ta tiếp tục tạo các sequence tiếp theo để tiếp 

tục thực hiện. 

Cách tạo Sequence được thực hiện như sau: 

Bước 1: Chọn File => New => Sequence trên thanh công cụ. 
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Hoặc tìm trong khu vực cửa sổ làm việc Project (Project Pannel) => New 

Item => Sequence 
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Với trường hợp bạn vừa tạo một project mới thì Adobe Premiere sẽ bắt buộc bạn phải 

tạo luôn một sequence mới. Ngay sau các bước tạo project mới thì sẽ xuất hiện hộp 

thoại New Sequence. Lúc này bạn đặt tên cho sequence rồi bấm OK là hoàn thành 

xong 
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Bước 2: Ở mục Sequence Presets lựa chọn trong danh sách Available Presets 1 

sequencen  

Bước 3: Đặt tên cho sequence rồi bấm OK là hoàn thành xong 

Import và quản lý file import 

Import 

Sau khi tạo xong project và sequence ta cần phải import các đoạn phim, âm thanh và 

hình ảnh để bắt đầu dựng phim. Có 4 cách để Import cụ thể: 



TÀI LIỆU THAM KHẢO 

 

 

 

DỰNG PHI VỚI ADOBE PRMIERE    29 

 

 

 

Cách 1: Kéo file video, hình ảnh, âm thanh thả trực tiếp vào Source Project 

Cách 2: Trên thanh công cụ chọn Menu => File => Import hoặc nhấn tổ hợp 

phím Ctrl + I, sau đó bạn chỉ cần lựa chọn file chưa hình ảnh, âm thanh và video mình 

muốn dựng bấm OK là xong 
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Cách 3: Trên cửa sổ Project bấm chuột phải vào vị trí bất kỳ trên cửa sổ sau đó chọn 

Import và lựa chọn file chứa dữ liệu rồi bấm ok là xong 

Cách 4: Kích đúp chuột vào cửa số project và chọn import và tiếp tục các thao tác 

như 3 cách trên để hoàn thiện. 

Quản lý file import 

Bạn cần quản lý các file import của mình bằng cách chia nhỏ nhiều thư mục và ghi rõ 

từng thư mục chứa dữ liệu gì để việc tìm kiếm sau này trở nên dễ dàng hơn. Bạn có 

thể chia thêm nhiều thư mục con ở các thư mục chính để giúp tôi ưu import nhất có 

thể. 

>>> Xem ngay: Hướng dẫn cách crop video trong Premiere CC chi tiết 

https://unica.vn/blog/huong-dan-cach-crop-video-trong-premiere-cc-chi-tiet
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Cắt ghép Video 
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Để thực hiện thao tác cắt ghép Video, bạn cần chú ý đến 2 công cụ chính như sau:  

- Move Tool (V): Dùng để kéo dài hoặc rút ngắn Video khi đưa chuột đến đầu phần 

Video cần cắt. 

- Razor Tool (C): Dùng để cắt Video theo ý muốn trên Timeline. 

Tùy vào độ dài của Video, bạn có thể lựa chọn một trong 2 công cụ để thực hiện thao 

tác với Video trên Timeline là hoàn thành.  

 

Chỉnh âm thanh 

Ngoài hai công cụ Move Tool và Razor Tool để chỉnh âm thanh, bạn có thể sử dụng 

các thao tác khác như sauK 

- Ấn icon M ở đầu thanh Audio trên Time để tắt tiếng 1 thanh Audio. 

- Bấm chọn icon S ở đầu âm thanh trong Timeline để chỉnh cho âm thanh phát tiếng.  
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Để thêm các hiệu ứng khác trong quá trình tùy chỉnh video, bạn thực hiện như sau: 

Bước 1: Chọn Clip có chứa file âm thanh cần chính sửa 

Bước 2: Mở Effect => Audio transitions => chọn hiệu ứng phù hợp.  

 

Bước 3: Kéo thả hiệu ứng vào vị trí âm thanh cần chỉnh. 

Bước 4: Điều chỉnh độ ngắn dài của Transitions trên Effect Controls.  

Tạo chuyển động 
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Để tạo chuyển động trong Premiere, bạn cần phải làm việc với Keyframe. Đây là vị trí 

trên một đường không gian đánh dấu sự bắt đầu hoặc kết thúc của quá trình chuyển 

đổi, tạo hiệu ứng di chuyển của một đối tượng đi từ điểm A đến B trong dòng thời gian. 

 

Cách thực hiện như sau: 

Bước 1: Chọn điểm bắt đầu. Công cụ điều khiển thời gian sẽ ở điểm đầu của đoạn 

Clip đó. 

Bước 2: Click vào đoạn Clip => vào mục Effect Control => chọn hiệu ứng Effect để 

sử dụng. 

Bước 3: Click bào biểu tượng có hình đồng hồ bên cạnh hiệu ứng vừa chọn 

trong Effect Control. 

Bước 4: Chọn điểm kết thúc.  
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3 bước chỉnh màu video trong Adobe Premiere 

Có thể nói rằng, chỉnh sáng video trong premiere là một trong những công đoạn 

hậu kỳ vô cùng quan trọng để sản phẩm của bạn tạo được điểm nhấn riêng biệt. 

Bước 1: Sử dụng tùy chỉnh công cụ Workspace và mở công cụ Adobe 

Premiere 

Để điều chỉnh, đầu tiên, bạn cần thay đổi lại vùng làm việc của phần mềm để 

thao tác với công cụ một cách nhanh chóng nhất. 

Bằng việc sử dụng Window -> Workspace -> Color hoặc đơn giản nhất nếu 

bạn biết mẹo sử dụng tab Color trên thanh Workspace. 

Sau khi bạn ấn tab xong, ngay lập tức một bảng tùy chọn mang tên Lumetri 

Color được mở ra. Công việc tiếp theo bạn đó chính là chọn video mình muốn chỉnh 

màu trên timeline rồi chỉnh trên Lumetri Color Panel. 
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Điều chỉnh công Workspace để điều chỉnh màu sắc video 

Bước 2: Điều chỉnh màu sắc và ánh sáng cho Footage với Basic Correction 

Bạn có biết, Basic Correction là một công cụ điều chỉnh màu rất quan trọng, nó 

bao gồm 4 tính năng chính: 

- Input LUT: Tính năng chính này cho phép người dùng lựa chọn một số Preset 

màu có sắn mà được nhà sáng lập tích hợp hoặc lựa chọn LUT mà người dùng có. 

Đây là cách thức giúp bạn có được video mới mà có màu sắc hiển thị ưng ý trong thời 

gian rất nhanh. 
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Cân chỉnh màu sắc với Basic Correction 

- White Balance: Tính năng này giúp cân bằng trắng cho footage trong trường 

hợp file nguyên gốc của bạn có vấn đề như bị nghiêng quá nhiều về 1 dải màu.  
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Cân chỉnh màu sắc với Basic Correction 

- Tone: Nó giúp cân chỉnh độ sáng tối trong trường hợp Footage nguyên bản 

sáng quá hoặc tối quá. 

- Saturation: Nó điều chỉnh sáng trong premiere độ bão hòa của kênh màu trong 

video. 

Bước 3: Chỉnh màu cho Footage 

Bước tiếp theo trong việc cách chỉnh màu trong premiere đó là điều chỉnh màu 

sắc một cách hài hòa. 

- Creative - Look: Công cụ này bạn có thể sử dụng các preset được gọi chung là 

Look, bạn Input vào phần mềm rồi lựa chọn, chỉnh sửa thêm thông tin phù hợp là OK. 
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Bạn cũng nên sáng tạo bằng việc sử dụng màu sắc riêng cho video của mình 

bằng công cụ Adjustment cho phép người dùng điều chỉnh Faded Film như bóng mờ, 

Sharpen tăng độ nét… 

 

Chỉnh màu cho Footage 
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Minh họa đối tượng sau khi điều chỉnh màu 

Các công cụ bổ trợ khác:  

- Color Wheels: Công cụ đổi màu trong premiere này được thể hiện bằng một 

vòng tròn màu sắc, bao gồm 3 phần Shadow, Midtones và Higlights để điều chỉnh màu 

của các vùng sáng nhất, sáng trung bình và vùng tối của hình ảnh. Để điều chỉnh độ 

sáng như mong muốn, bạn chỉ việc kéo tâm diêm của nó phần mà mình chọn. 
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- Vignette: Là công cụ chỉnh màu đen trắng trong premiere viền vùng tối bao 

quanh, tập trung vào làm nổi bật điểm chính giữa của khung hình. Với công cụ này, 

không thể thay đổi điểm chính giữa hay hình dạng của nó.  
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Adobe Premiere – Thư mục hiệu ứng bách khoa toàn thư – Ý nghĩa và mục 

đích các hiệu ứng thường dùng 

I. Hiệu ứng video 

 

1. Mục ADJUST – hiệu chỉnh 

– Auto Color: tự động chỉnh màu hình ảnh 

– Auto Contrast: tự động chỉnh tương phản 

– Brightness & Contrast: Hiệu chỉnh tương phản dựa trên sáng tối và tương phản 

của hình 

– Channel Mixer: Hiệu chỉnh màu bằng cách trộn mỗi kênh theo giá trị từ RGB 

(kênh xanh lá, kênh đỏ, kênh xanh dương) 

– Color Balance: Hiệu chỉnh theo màu RGB. Được sử dụng để sửa hình ảnh 

chệch màu dựa vào điều kiện ánh sáng tại thời điểm ghi hình 

– Convolution Kernel: hiệu chỉnh giá trị sáng tối của từng pixel tỉ mỉ theo hiệu ứng 

mong muốn 

– Extract: chuyển hình ảnh thành trắng đen, cụ thể bằng cách chỉnh được cân 

độ theo khu vực màu trắng và đen 

– Levels: thay đổi màu của hình, sáng và tối theo đồ thị cân độ dựa trên giá trị 

kênh RGB 

– Posterize: đổi số lượng màu sắc có trong một hình 

– ProcAmp: gần giống với LEVEL, không chỉnh được theo giá trị từng kênh màu, 

chỉnh cả tông toàn hình 

– Shadow / Highlight: làm cho vùng tối tối hơn và phần sáng sáng hơn 

– Threshold: chuyển đổi đen trắng với biên độ 
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2. Mục Blur – làm mờ 

– Antialias: chống răng cưa, làm mềm phần biên mép theo pixel 

– Camera Blur: làm hiệu ứng xóa phông theo kiểu từ camera 

– Channel Blur: làm mờ theo từng kênh RGB và cả kênh Alpha 

– Compound Blur: gom toàn pixel của một hình và làm cho nó nhìn mượt hơn 

– Directional Blur: tạo hiệu ứng làm mờ theo một hướng mong muốn 

– Fast Blur: tạo hiệu ứng làm mơ theo phương ngang và thẳng đứng 

– Gaussian Blur: tạo hiệu ứng làm mờ với cường độ nhiều hơn các hiệu ứng làm 

mờ khác. Cũng có thể chọn được phương làm mờ như Fast Blur 

– Gaussian Sharpen: làm nét (sharp) theo pixel 

– Ghosting: tạo hiệu ứng bóng ma xung quanh vật thể chuyển động – giả làm 

mờ chuyển động 

– Radial Blur: tạo hiệu ứng làm mờ theo thấu thị (tròn) 

– Sharpen: làm nét hình theo điểm tương phản của pixel 

– Sharpen Edges: làm nét cạnh theo màu trên hình 

– Unsharp Mask: tạo hiệu ứng làm nét hình và có thể nét căn, có nhiều tùy chọn 

vào hiệu ứng Radius có thể lam tăng tương phản với biên độ giới hạn mong muốn qua 

chức năng Thresold 

3. Mục Channel 

– 3D Glasses: tạo hiệu ứng giả 3-D nổi 

– Arithmetic: tạo hiệu ứng mono tone theo kiểu tinh chỉnh kênh RGB 

– Blend: tạo hiệu ứng trộn, có 5 mode 

– Calculations: hiển thị chỉ kênh màu mong muốn 

– Cineon Converter: tạo hiệu ứng giả ảnh phim 

– Compound Arithmetic: tạo dựng đầu vào 2 hình thành kết quả từ các kênh 

mong muốn 

– Invert: tạo hiệu ứng âm bản 
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– Set matte: kết hợp với clip hiện tại thông qua kênh mong muốn dựa tên clip 

đang chọn ở phần Take Matte From Layer 

– Solid Composite: kết hợp 2 clip theo kiểu trộn và dựa trên điều kiện là màu 

RGB chọn theo picker 

4. Mục Distort 

– Bend: tạo ra hiệu ứng bẻ cong hình theo phương trục tung (ngang) và hoành 

(đứng) 

– Corner Pin: làm biến đổi hình bằng cách thay đổi giá trị góc dựa trên 4 điểm 

(pin) xác định 

– Lens Distortion: làm biến dạng hình ảnh 

– Magnify: tạo hiệu ứng kính lúp – hiệu quả phóng to theo một phần cụ thể của 

hình 

– Mirror: phản chiếu theo kiểu gương, tạo ra hình ảnh đối xứng theo trục tung 

hoặc hoành 

– Offset: thay đổi vị trí của hình mà nó sẽ vượt theo biên dựa trên giá trị đầu vào 

– Polar Coordinates: tạo hiệu ứng xoáy ngay trung tâm hình 

– Ripple: tạo hiệu ứng sóng nước 

– Spherize: tạo hiệu ứng vòm cầu từ trung tâm hình 

– Transform: biến dạng thay đổi hình theo góc xoay, xoáy, giãn theo chiều rộng, 

và chiều cao 

– Turbulent Displace: tạo hiệu ứng biến dạng hình ảnh náo loạn, hỗn mang 

– Twirl: tạo hiệu ứng xoáy lên ảnh 

– Wave Warp: tạo hiệu ứng vân sóng 

5. Image Control Folder 

– Black & White: Chuyển sang trắng đen 

– Change Color: thay đổi màu theo một tông màu chọn theo mong muốn 

– Change To Color: giống kiểu Change Color nhưng chuyển theo màu từ màu 

mong muốn từ From thành To 

– Color Balance (HLS): chỉnh Hue, Lightness và Saturation 
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– Color Balance (RGB): hiệu chỉnh màu trong kênh RGB (red, green, blue) 

– Color Corrector: tạo hiệu ứng chỉnh sửa màu, có curve để chỉnh chuẩn xác, 

chủ yếu dùng để chỉnh cân bằng trắng khi bị sai sau khi ghi hình 

– Color Match: đổi thành màu mong muốn dựa trên các khu vực master, shadow 

(bóng đổ – tối nhất), midtone (trung), highlight (khu sáng nhất) 

– Color Offset: di chuyển vị trí giá trị màu của một kênh theo hướng mong muốn, 

có thể tạo hiệu ứng chromatic aberration (kiểu lé màu) 

– Color Pass: thay đổi phần còn lại của màu đã chọn thành trắng đen 

– Color Replace: thay thế màu đạ chọn với một màu khác 

– Equalize: trung bình hóa toàn bộ màu sắc và ánh sáng của một clip 

– Gamma Correction: thay đổi giá trị gamma 

– PS Arbitrary Map: xoay màu theo góc độ dựa trên giá trị mong muốn 

– Tint: chọn khu vực màu sáng hoặc tối rồi nhuộm theo màu mong muốn 

6. Mục Noise 

– Median: thay đổi giá trị RGB của từng pixel trên mỗi giá trị RGB pixel gần nhau, 

để làm cho noise mất đi 

7. Mục Noise & Grain 

– Dust & Scratches: loại bỏ các nhiễu hạt và bụi ra khỏi hình, gần giống Median 

nhưng có giá trị Radius để tăng cường 

– Noise Alpha: tạo hiệu ứng tự nhiên qua sự không đồng đều của nhiễu hạt 

– Noise HLS: tạo ra hiệu ứng nhiễu hạt dựa trên: Hue, Light, and saturation. 

– Noise HLS Auto: giống kiểu tạo nhiễu hạt HSL nhưng các hạt trong nhiễu sẽ 

có thể di chuyển trong quá trình playback. Noise Animation Speed thay đổi tốc độ thay 

đổi vị trí 

8. Mục Perspective 

– Basic 3D: xoay chuyển hình theo trục tung hoặc hoành, giả chiều sâu 

– Bevel Edges: tạo hiệu ứng ngay mép hình giả nổi như khung 

– Bevel Alpha: tạo hiệu ứng nổi cho kênh alpha của hình 
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– Drop Shadow: tạo hiệu ứng đổ bóng 

– Radial Shadow: tạo hiệu ứng đổ bóng, chỉnh được phương 

9. Mục Pixelate 

– Facet: gom các pixel giống giá trị màu để tạo ra ảnh như màu nước 

10. Mục Render 

– 4-Color Gradient: tạo hiệu ứng gradient từ 4 màu 

– Cell Pattern: tạo ra pattern nhỏ 

– Checkerboard: tạo ra một phiên bản checkerboard (bàn cờ), thường để kiểm 

tra xem hình gốc có bị biến dạng không khi so theo trục tung và hoành 

– Circle: tạo ra một vòng tròn 

– Ellipse: tạo ra một cái hình Ellipse 

– Eyedropper Fill: thay đổi màu theo vị trí chọn trên hình 

– Grid: tạo ra một hiệu ứng lưới đều trên hình 

– Lens Flare: tạo hiệu ứng lóa sáng 

– Lightning: tạo vệt sáng từ 2 điểm 

– Paint Bucket: đổ màu theo khu vực chọn trên hình 

– Ramp: tạo hiệu ứng giống gradient theo điểm và vị trí 

11. Mục Stylize 

– Alpha Glow: tạo nổi sáng mép của kênh alpha – có thể dùng kết hợp với các 

kiểu như làm mượt và mềm mép để tạo hiệu ứng chống răng cưa để trộn kênh 

– Brush Strokes: hiệu ứng như kiểu dùng cọ vẽ 

– Color Emboss: tạo hiệu ứng bề mặt lồi lõm theo kiểu thay đổi vị trí biên của 

màu 

– Emboss: tạo hiệu ứng bề mặt lồi lõm trên toàn hình 

– Find Edges: xác định chỉ viền bao của một đối tượng. Dùng invert để làm ngược 

màu 

– Leave Color: toàn bộ thành trắng đen ngoài trừ màu đã chọn 

– Mosaic: tạo hiệu ứng Mosaic 
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– Noise: tạo ra thêm nhiễu hạt lên hình 

– Replicate: chia hình ra thành nhiều phần với nhiều phiên bản 

– Roughen Edges: tạo hiệu ứng lộn xộn biên cạnh hình, giống như 1 khung hình, 

có thể chỉnh được với nhiều thông số như loại frame và độ dày 

– Solarize: tạo hiệu ứng bị cháy màu vì quá nóng, nếu đẩy tham số lên cao thì 

gần như là âm bản 

– Strobe Light: tạo hiệu ứng chớp sáng như chụp hình máy ảnh 

– Texturize: tạo hiệu ứng vật liệu lên hình từ nguồn chọn đầu vào 

– Write-on: tạo hiệu ứng đang viết bằng cọ 

12. Mục Time 

– Echo: tạo thêm hiệu ứng chồng hình, kiểu hồi xưa coi phim kung-fu khi thấy 

đang tập luyện tay chân hiện ra liên tục 

– Posterize Time: thay đổi số frame trên giây 

13. Mục Transform 

– Camera View: Tạo hiệu ứng zoom, xoay và nghiêng 

– Clip: cắt phần đầu, dưới, trái phải của hình theo thông số mong muốn 

– Crop: cắt như kiểu clip xong phóng to lên với chức năng zoom. Clip thì có thể 

đổ màu 

– Edge Feather: tạo thêm viền mờ đen trên cạnh hình 

– Horizontal Flip: lật hình theo trái phải trục hoành 

– Horizontal Hold: nghiên hình 

– Roll: trượt (scrolls) hình theo các hướng mong muốn trái phải trên dưới, như 

kiểu làm phụ đề hội thoại hay chạy tên credit 

– Vertical Flip: lật hình theo trục tung 

– Vertical Hold: cho hình chạy lên, giống kiểu máy CRT đang chạy 

14. Mục Transition 

– Block Dissolve: tạo hiệu ứng biến đi theo dạng hạt 

– Gradient Wipe: tạo hiệu ứng chuyển cảnh theo vùng gradient 
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– Linear Wipe: chuyển từ hình này qua hình khác (chuyển cảnh) từ trái qua phải, 

clip nằm dưới sẽ hiện ra, có thể thay đổi góc độ 

– Radial Wipe: theo chiều kim đồng hồ, hình nằm track dưới hiện ra 

– Venetian Blinds: tạo hiệu ứng chuyển hình như kiểu thanh rèm cửa 

15. Mục Video 

– Broadcast Colors: chuẩn hóa màu theo monitor máy tính với màn hình video 

ngoài (external) khi làm việc trên nhiều màn hình 

– Field Interpolation: Fills the dropped portion naturally during capture. 

II. Hiệu Ứng Âm Thanh 

 

1. Mục Band Pass 

– Highpass: lọc ra tần số cao nhất 

– Lowpass: lọc phần tần số thấp nhất 

– Notch / Hum: loại bỏ tiếng ồn và tiếng Hum 

2. Mục Channel 

– Auto Pan: tạo hiệu ứng giả lập âm thanh chạy trái phải tự động 

– Fill Left: cho phát chỉ kênh trái 

– Fill Right: cho phát chỉ kênh phải 

3. Mục Dynamic 

– Boost: khuếch đại âm 

4. Mục Effect 

– Chorus: tạo hiệu ứng vang vọng lên âm như kiểu đồng ca 
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5. Mục Reverb & Delay 

– Echo: tạo hiệu ứng hồi âm như kiểu karaoke 
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